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摘    要

職等二人經總公司核准，於92.10.13赴英國Actix公司研習該公司Actix後級分析軟體實習課程為期14天，主要目的係進一步學習Actix分析軟體GSM/GPRS相關指令之操作及步驟。本分公司目前GSM/GPRS RSV(Radio Site Verification)後級分析工具均係使用該公司所研發之Actix Analyzer，同時3G工程案所提供之路測設備，亦是選擇此套軟體做為其後置分析工具，足見其重要性。本報告將針對GSM/GPRS部分之操作使用做進一步介紹，期能提供品質改善單位之同仁參考並有所助益，進而提昇整體網路品質。
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目的及過程

壹、目的

職等依中華電信股份有限公司九十二年十月七日信人二字第92A3501737號赴英國實習GPRS行動數據網路品質分析、改善及優化技術，此行主要目的為了解Actix分析軟體設備之性能及相關指令之操作及分析，並學習相關技術，俾利日後維運作業之分析工作。
貳、過程

	日期
	地點
	行程

	92/10/13 ~ 92/10/14
	台北–英國利物浦
	去程

	92/10/15 ~ 92/10/24
	利物浦
	參加實習

	92/10/25 ~ 92/10/26
	英國利物浦-台北
	回程


參、心得

第一章.GSM/GPRS概述

GSM系統架構：如下圖。

[image: image1]
1.1空中介面(Um)之信號規約：共有三層。

(1)實體層 (Level 1) - 實體通道
將可用頻率依 200 kHz寬度切割成載波，每一載波再依時間分割成 8 個時槽，每個時槽可為語音或信號，此時槽稱為實體通道(Physical Channel)。每一時槽佔 0.577 ms，內含 156.25 Bits，其中只有 114 個Bits用來傳送加密過的語音。

(2)LAPDm(Level 2) - 邏輯通道

為確保傳輸品質，並將應用層的資訊轉換到實體的通道上，GSM將LAPD(Link Access Protocol on D channel)規約補充修改，加入無線傳輸的部分如Error Rate及Hand Over等，使之成為MS與BTS間使用的第2層規約，稱為LAPDm。LAPD可承做二種傳輸模式：

a.不需回應(non-acknowledged)的碼框：
單一方向傳送的通道如廣播用(BCCH)、呼叫用(PCH、AGCH)等都屬此類。
b.需回應(acknowledged)的碼框：

均為專屬通道(SDCCH、FACCH、SACCH等)，當收到錯誤碼框時會重送。

(3)應用層 (Level 3) - CM、MM、RR。此層係所有從事RF工作之人員最關切的部分，於此層可產生有意義之資訊，其資訊可分三大類：

CM (Connection Management) - 連結管理：

1.呼叫控制程序 - 如呼叫建立與釋放。

2.增添服務程序 - 增添服務的管理。

3.簡訊服務程序 - 由簡訊控制部分轉送簡訊給特定行動台。

MM (Mobility Management) - 移動管理：

註冊、用戶位址及認證等程序皆屬此類。

RR (Radio Resource Management) - 無線電資源管理：

通道分配、加密模式管理、交遞準備與執行、功率控制等等屬之。

運用Actix Analyzer來分析路測資料，由Layer 3 message之判讀及驗證，從而找出網路問題之原因，係優化工作中不可或缺的一環。

1.2 頻道觀念：GSM系統無線電介面上的頻道可以兩種觀點來探討：

(1)實體頻道：

在一載波頻道(佔200KHz頻寬)上的TDMA碼框中的一個時槽(timeslot)，即稱之為一實體頻道。在GSM系統中，每個載波頻道均以TDMA多工進接方式將每個TDMA碼框劃分為8個時槽，故每個載波頻道均有8個實體頻道(實體頻道0-7，對應於時槽0-7)。

(2) 邏輯頻道：

GSM系統在基地台(BTS)與行動台(MS)之間需傳送大量且多樣化的資訊，如用戶語音、系統參數及控制信號等。GSM系統即依據所傳送訊息之種類，賦與其不同之邏輯頻道名稱。如話務頻道、共同控制頻道及專屬控制頻道等。這些邏輯頻道須依據一些特定對映關係，對映到特定的實體頻道上。譬如，一傳送用戶語音的邏輯頻道，GSM系統稱之為話務頻道(Traffic Channel，TCH)，在傳送時，系統須指配某一個實體頻道來傳送它。若干個邏輯頻道可以共用同一個實體頻道。

(3) 邏輯頻道種類
 可分為二大類：
a.話務頻道(Traffic Channel，TCH)：話務頻道可用來傳送數位化編碼之語音訊息(Encoded Speech)或用戶數據訊息(User Data)。屬於點對點的傳送，包括上鏈及下鏈頻道。而依據傳送速率之不同，話務頻道又可分為：
‧全速率話務頻道(Full-rate TCH，TCH／F) - 可傳送：

- 總速率為22.8 Kbps(淨速率為13 Kbps)之語音(TCH/FS)

- 9.6 Kbps 之數據(TCH/F 9.6)或
4.8 Kbps 之數據(TCH/F 4.8)或
≦ 2.4 Kbps 之數據(TCH/F 2.4)

‧半速率話務頻道(Half-rate TCH，TCH/H) - 可傳送：
- 總速率為11.4 Kbps(淨速率約6Kbps)之語音(TCH/HS)
- 4.8 Kpbs 之數據(TCH/H 4.8)或

≦ 2.4 Kbps 之數據(TCH/H 2.4)

b.控制頻道(Control Channel，CCH)：控制頻道(CCH)係用來傳送，諸如行動台被呼叫時之傳呼訊息、行動台欲發話時之進接訊息、及各種信號或同步訊息等。控制頻道又可區分為廣播頻道(BCH)、共同控制頻道(CCCH)及專屬控制頻道(DCCH)等三類。
‧BCH (Broadcast Channel) - 廣播頻道：
廣播頻道(BCH)屬於點對多點的傳送，只有下鏈頻道。依其傳送訊息功能之不同，又可分為以下三種：
-FCCH (Frequency Correction Channel) - 頻率校正頻道：
傳送供行動台做頻率校正所需之訊息。
-SCH (Synchronization Channel) - 同步頻道：
傳送供行動台做碼框同步所需之訊息及BTS之識別訊息等。
-BCCH (Broadcast Control Channel) - 廣播控制頻道：
BCCH廣播每個BTS的細胞特定訊息(Cell Specific Information)，譬如，該細胞屬於那個GSM網路(MCC、MNC)、細胞識別碼、該細胞所屬之位置區、該細胞之頻率指配、是否有DTX功能、所允許之GSM網路及躍頻順序(Frequency Hopping Sequence)等。BCCH訊息佔4個TS-O，每隔235ms廣播一次。行動台在空閒狀態時，可能會接收到好幾個分屬不同網路甚至不同國家的細胞所送出的信號。行動台必需選擇其中之一來收聽或進一步通信，此項選擇須依賴收聽各細胞經由BCCH頻道定時廣播之細胞特定訊息，才能完成。
‧CCCH (Common Control Channel) - 共同控制頻道：
共同控制頻道(CCCH)包括傳呼頻道(PCH)、隨機進接頻道(RACH)及進接許可頻道(AGCH)，主要做為呼叫建立及管理之用途。

-PCH (Paging Channel) - 傳呼頻道：
傳呼頻道(PCH)係用來呼叫(尋找)某一行動台，以確定該行動台是否仍在其服務區內。此頻道為下鏈頻道，屬於點對點的傳送。
-RACH (Random Access Channel) - 隨機進接頻道：
當行動台欲發話、或向系統做註冊時，皆須先利用此隨機進接頻道來向系統提出進接請求。此隨機進接頻道為上鏈頻道，亦屬於點對點的傳送。
-AGCH (Access Grant Channel) - 進接許可頻道：
進接許可頻道被用來指配一單獨專屬控制頻道(Stand-alone Dedicated Control Channel，SDCCH)給某一行動台。此頻道為下鏈頻道，亦屬於點對點的傳送。
‧DCCH (Dedicated Control Channel) - 專屬控制頻道：
專屬控制頻道(DCCH)包括「單獨專屬控制頻道」、「慢速聯合控制頻道」及「快速聯合控制頻道」三種。三者均屬點對點之傳送，亦均有上/下鏈頻道(Bidirectional)。茲分述如下：
-SDCCH (Stand-alone Dedicated Control Channel) - 單獨專屬控制頻道：
在呼叫建立期間，系統為一行動台指配一話務頻道(TCH)前，須先利用此單獨專屬控制頻道來傳遞信號。
-SACCH (Slow Associated Control Channel) -慢速聯合控制頻道：
慢速聯合控制頻道(SACCH)是與一話務頻道(TCH)或－單獨專屬控制頻道(SDCCH)聯合使用，為一連續之數據頻道。用來傳送下列各種較不急迫之訊息：                              

· a 行動台測量其服勤細胞與相鄰細胞之「收訊強度」與「收訊品質」之測量結果。
· b 「行動台發射功率控制」訊息，為下鏈訊息。
· c 「與行動台之距離」，即「時間調齊」(Time Alignment)訊息。              
-FACCH (Fast Associated Control Channel) - 快速聯合控制頻道：
快速聯合控制頻道(FACCH)通常與一話務頻道(TCH)相聯合使用此時快速聯合控制頻道工作於竊取模式(Stealing Mode)。即當通話中，TCH正在傳送語音訊號時，若系統必須以更高之速率(非SACCH所能應付者)與行動台交換信號訊息時，系統會竊取整個語音突波(Speech Burst)之時槽來傳送此信號訊息。此時用戶應不會感覺到語音中斷之現象。此快速聯合控制頻道之竊取模式，通常發生在執行交遞程序時。

1.2 GPRS系統架構：如下圖。
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(1) GPRS網路是在既有GSM CS(Circuit Switch)網路上，增建PS (Packet Switch)網路，以因應未來數據服務需求，因此整體網路便引進新的網路元件如 PCUSN, SGSN, GGSN，共同點僅是重複使用既有GSM實體基地台，但須進行基地台軟體升版以使基地台具備GPRS數據處理能力。SGSN的功能包括持續追蹤個別MS的位置，執行保密功能與進接控制，GGSN主要用來與外部數據網路建立通信管道。另外在BSC內加入PCU (Packet Control Unit)，PCU支援GPRS所需的新通信協定，並處理頻道指配與無線通道管理的功能（如功率控制）。PCU與BSC間的介面為Agprs介面，Agprs的通信協定並不公開。

(2) 有關GPRS空中介面的程序方面，GPRS的手機在傳送或接收資料時，主要可分成三個階段：TBF (Temporary Block Flow)建立、資料傳遞與TBF釋放。在建立階段，為了避免系統過載，必須限制使用者的數目，即進行允許控制。在資料傳遞時，為了節省MS的電力並提高頻譜效益，MS將進行功率控制。當空中介面通信品質不佳，導致資料無法被接收端接收時，傳送端將再次重傳未被接收的data block，若傳送多次仍然失敗，該鏈路將被釋放掉。

(3) 在建設初期，GPRS的部分頻道將不使用而與GSM共用頻道（控制頻道），如PBCCH與PCCCH分別以BCCH與CCCH取代，其好處是可節省頻道資源，但相對的GPRS許多功能都無法實現而必須遷就GSM的設定。GPRS的頻道可配置在BCCH或TCH頻道上，但由於BCCH頻道通常較能提供良好的通信品質，故以BCCH頻道為優先考慮。對於每個GPRS頻道（時槽），可設定為GPRS獨佔或GPRS與GSM共用，若設為獨佔，表示細胞無論何時至少能提供某一定量的資料傳送服務，若獨佔的頻道過多，容易造成細胞阻塞。至於一個細胞要規劃幾個頻道給GPRS使用，可視細胞的資料傳輸量而定。
(4) 在一載波頻道（佔200kHz頻寬）上的TDMA碼框中的一個時槽即稱之為一實體頻道。此外，系統依據所傳送訊息的種類，賦予其不同的邏輯頻道名稱，這些邏輯頻道需依據一些特定的對應關係，對應到特定的實體頻道上。在使用邏輯頻道傳送時，系統需指配某一個實體頻道來傳送它，而若干個邏輯頻道可以共同使用同一個實體頻道。

(5) GPRS系統引入數種邏輯頻道至GSM空中介面，包括PTCH、PDCCH、PBCCH與PCCCH四大類，其中PDCCH與PCCCH又由數個子頻道(Subchannel)所組成，如下表。PBCCH用來廣播分封數據有關的系統資訊(System Information)，PCCCH可用來呼叫MS或當MS進接時使用。若細胞未分配這兩類頻道，可分別使用BCCH與CCCH頻道取代。Phase 1與Phase 2的手機僅會使用CCCH，但使用PCCCH可最佳化GPRS。目前僅使用PTCH(PDTCH)與PDCCH（包括PACCH與PTCCH子頻道）兩類頻道。

                      GPRS邏輯頻道表

	分類
	通道名稱
	功能

	 PTCH (Packet Traffic Channel)
	 PDTCH
	 分封數據訊務

	 PDCCH (Packet Dedicated Control Channel)
	 PACCH
	 分封關聯控制

	
	 PTCCH
	 分封時間提前控制

	 PBCCH (Packet Broadcast Control Channel)
	 PBCCH
	 分封廣播控制

	 PCCCH (Packet Common Control Channel)
	 PPCH
	 分封呼叫

	
	 PNCH
	 分封公告

	
	 PAGCH
	 分封存取允許

	
	 PRACH
	 分封隨機存取


a.PDTCH(Packet Data Traffic Channel)

在GPRS的邏輯頻道中，用來傳送資料的頻道為PDTCH，它暫時專屬於一行動台，在多重時槽(Multislot)的運作中，一行動台可能使用數個PDTCH作為個別的封包傳遞，即在一個TDMA碼框的8個時槽內，佔用數個時槽來傳送資料，如此可增加傳輸速率。所有的PDTCH皆為單向，可能是上鏈路行動台用來傳遞封包的PDTCH/U，或是在下鏈路行動台用來接收封包的PDTCH/D。
b.PACCH(Packet Associated Control Channel)

PACCH為雙向，用來傳遞一些控制訊息，例如接收端（MS或網路端）回應傳送端封包的接收情形，資源指配所需的訊息等。PACCH從PDTCH中分享資源，並持續指配到一MS。
c.PTCCH/U(Packet Timing advance Control Channel, uplink)

在Packet transfer mode，MS使用PTCCH/U傳送隨機進接突波，基地台根據收到的進接突波來估算時間提前值。
d.PTCCH/D(Packet Timing advance Control Channel, downlink)

PTCCH/D用來傳送更新的時間提前資訊至數個MS。一個PTCCH/D可配上數個PTCCH/U。

(6) 實體頻道用來傳送邏輯頻道，不同的GPRS邏輯頻道可以對應到相同的實體頻道PDCH (Packet Data Channel)，所以GPRS的實體頻道稱為PDCH，更簡單來說，細胞內分配給GPRS使用的頻道（時槽），統稱為PDCH。PDCH為數個MS與網路間的一個分享媒介。
1.3 GPRS允許的頻道組合

由於某些邏輯頻道所傳送的資訊速度均遠低於一個實體頻道的速度，為了提高實體頻道的使用率，系統將若干個邏輯頻道，依使用類別及性質分類組合後，再多工對應到實體頻道上。GPRS基本實體頻道允許的頻道組合共有三種，分別為：

· PBCCH + PCCCH + PDTCH/F + PACCH/F + PTCCH/F

· PCCCH + PDTCH/F + PACCH/F + PTCCH/F

· PDTCH/F + PACCH/F + PTCCH/F

    其中PCCCH = PPCH + PRACH + PAGCH + PNCH，F為full rate。

以上三種組合，差別只在是否使用PBCCH與PCCCH而已。目前採用第三種，不使用PBCCH與PCCCH頻道，所以 Radio block僅由PDTCH與PACCH兩種邏輯頻道組成。細胞內若不分配PBCCH、PCCCH頻道，可分別使用BCCH、CCCH取代。使用BCCH與CCCH來執行GPRS程序的好處是節省無線資源，尤其當是當頻道不夠的情形之下，然而相對的，GPRS的一些功能便無法執行，無法讓GPRS的效能達到最大。若細胞內有PBCCH，其使用頻率不一定要與BCCH相同。
(1) 時槽共享

 GPRS仍然延用原本GSM之TDMA碼框架構。每一個碼框中的八個時槽，可以將部分規劃成GSM語音服務專用，部分規劃成GPRS數據服務專用，部分規劃成GSM語音服務與GPRS數據服務共用，但GSM語音服務通常具有較高優先權。如果無線通道資源足夠，甚至可以規劃某些載波上的八個時槽都供GPRS使用。
Nortel BSS系統有關GPRS時槽分享的參數，共有下列幾個：

· channelType：channelType 為時槽邏輯頻道的形式，包括tCHfull / sDCCH / mainBCCH / mainBCCHCombined / bcchsdch4CBCH / sdcch8CBCH / cCH / pDTCH，若TS要支援GPRS服務，則將channelType 設為pDTCH。

· minNbOfGprsTs：細胞內GPRS專用的最小時槽數。

· gprsPreemption：此參數適用在GSM/GPRS的共用時槽。平時GSM並不會去佔用共用時槽，只有當TCH已用完，GSM才會去搶用。此參數若設定No，在共用時槽上，一旦有GSM服務請求（已無GSM專用頻道），即使正在進行GPRS資料傳遞，也要暫時中斷而將頻道釋出。若設定YES，在共用的時槽上，當GPRS資源充足，一旦有GSM服務請求，共用時槽仍會釋出頻道讓GSM使用，但當GPRS資源不充足，不能對每個MS保證最小的頻寬時，PCU將拒絕GSM先佔有。根據實驗結果，若MS佔有兩個時槽接收資料，當有GSM服務請求時，將釋出一個時槽給GSM使用，但當MS只佔用一個時槽接收資料，該時槽將不會被釋出。

· gprsPreemptionProtection：此參數只有當gprsPreemption = Yes時才有作用。當GSM缺少時槽時，BSC必須分配一個共用的GSM/GPRS時槽給GSM，此時啟動preemption（搶先佔用）程序，在preemption程序期間，PCU將拒絕GSM服務前來佔用GSM/GPRS共用頻道。preemption程序的時間由此參數定義，設定值為1 – 60秒。

(2) GMM與SM
    GPRS連接到網路的過程可分成兩個階段(Phase)：

· 連接到GSM網路：GPRS Attach；

· 連接到外部網路：PDP Context Activation。

    在第一階段關注使用者移動性，稱為GPRS的行動管理(GPRS Mobility Management, GMM)，用來追蹤在PLMN內MS目前的位置，而第二階段用來處理GPRS MS至外部數據網路的連接管理，稱為SM (Session Management)。

(3) GPRS空中介面程序
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在介紹GPRS相關的空中介面的原理之前，將先介紹GPRS的傳輸平面(Transmission Plan)與MS-SGSN的控制信號傳輸平面(Signalling Plan)，其中傳輸平面由不同層的通信協定結構所組成，用來提供使用者資訊轉換與相關資訊傳送的控制程序，GPRS的傳輸平面如圖A。控制信號平面由控制及支援傳輸平面的功用的通信協定所組成，而MS-SGSN間的控制信號平面由支援GMM與SM功能(Functionality)的通信協定所組成，MS-SGSN的控制信號平面下圖

圖A 傳輸平面
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圖B MS-SGSN控制信號平面

有關GPRS空中介面的功能可由GMM/SM與RLC/MAC (Radio Link Control / Medium Access Control)層的程序來完成，兩者除了在通信協定的層次上不同外，一般而言，RLC/MAC層的功能通常只侷限在MS與BSS端間，GMM/SM則在NSS與MS間有意義，有時與BSS並無直接關係（SM），本文將把重心放在RLC/MAC層的重要程序上。其中RLC的功能為：

· 分割LLC (Logic Link Control) PDU (Protocol Data Unit)成為RLC data block（從上層至RF層），與重整RLC data block成為LLC PDU（從RF層至上層）；

· 重傳RLC data block。

而MAC的功能為處理多工問題，讓MS能夠共享傳輸資源。
RLC/MAC層的空中介面可藉由一些程序與其相關參數來瞭解，這些程序包括：

· TBF的建立：目前上下鏈路一律使用2-phase進接；

· 允許控制：進接時的人數限制；

· 資料傳遞：目前使用固定分配方式；
· TBF的釋放：上鏈路為倒數程序，下鏈路為當MS收到FBI位元時；
· 細胞重選：主要沿用GSM重選方式；
· 功率控制：目前僅MS執行功率控制，BTS並不執行；
· Sliding window：用於重傳機制；
· Radio link failure：處理無線鏈路的不正常釋放，相當於GSM的斷話。

在GPRS的標準裡，共有四種空中介面的Coding scheme：CS-1、CS-2、CS-3與CS-4。CS-1具有最高的錯誤更正能力與最低的資料傳輸速率， CS-4沒有錯誤更正能力但具有最高的資料傳輸速率。不同的Coding scheme與資料速率的關係如下表，目前系統只支援CS-1與CS-2兩種，若要支援CS-3與CS-4需更換舊有的TRX。若MS支援3個時槽接收資料，同時使用CS-2編碼，則下傳速度最快為13.4 * 3 = 40.2 kb/s。

Coding Scheme與資料速率對照表

	Scheme
	Data Rate kb/s

	CS-1
	9.05

	CS-2
	13.4

	CS-3
	15.6

	CS-4
	21.4


下一章將開始介紹Actix Analyzer之安裝及操作。

第二章 Actix_Analyzer簡介
所謂的Analyzer，係指一種多功能、可接受各種行動通信技術之performance data並加以判讀之PC-based分析工具(如下圖)。它同時可滿足廣泛的應用領域：

· 網路效能優化(Network performance optimization)。
· 特性測試(Feature testing)。

· 服務驗證(Service validation)。

· 問題診斷及分析(Problem diagnosis and analysis)。

· 網路競爭力分析(Network bench-marking)。
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支援Multi-technology, multi-vendor
資料之分析

2.1有關Actix Analyzer

Actix Analyzer™即是一個蜂巢式行動電話系統的後級分析處理工具，在PC上的 Microsoft Windows環境中運行。Actix Analyzer能夠接受許多來源資料包括場測設備和交換呼叫路由的網路表現資料。資料可以單獨測試，也可以作爲一系列抽樣中的一部分來建立整個網路表現的形象。來源資料讀入後，多種分析和顯示工具將會爲工程師、技術人員和操作管理人員清晰展示網路表現的狀況。
2.2安裝Actix_ Analyzer軟體
(1) 電腦硬體需求:
–RAM: 512 MB
–可用硬碟空間: 1 GB

–OS: Windows 98 or Windows 2000 Professional

–Office 97 or 2000
–Internet Explorer 5.5 or above
(2) 調整電腦虛擬記憶體:
–Go to 控制台, open 系統.
–Go to 進階(效能, click on 設定.

–Go to 進階(虛擬記憶體, click on 變更.

–Set minimum 磁碟分頁檔大小起始值 to 500 MB, 最大值 to 768 MB.
(3) 將硬體鎖(Dongle)，放置於欲安裝電腦之序列埠。
(4) 將Actix Analyzer安裝光碟置入CD槽，程式將執行自動安裝。
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(5) 安裝的使用者及公司名稱為CHT-M
(6) 安裝結束後，至安裝光碟中尋找”ActixSPX_Map_20020807.exe”及”SP5-Agilent-2002-08-13.exe”二個程式並執行之。

(7) 至網維處三科FTP網站(10.81.188.192)，選擇/參考資料區/RSV專區/Agilent場測設備相關資料/設備安裝軟體/ACTIX_相關安裝軟體/，下載ACTIX Customization 安裝程式目錄至安裝Analyzer電腦，開啟目錄中ACTIX安裝說明.txt，依此說明檔完成安裝Analyzer。
(8) 至TIME網站(http://time.chtldm.com.tw)中RSV專區下載Actix license file， 將下載之“lservrc” 放置在安裝Analyzer電腦中之    “C:\Program Files\Actix\Analyzer\Bin\

(9) 在RSV專區中選擇基地台資料庫檔案下載，下載最新基地台資料庫至c:\Program Files\Actix\Analyzer\Bin\Cellrefs\，並將檔案名稱改為cellrefs.txt。
第三章. Actix_Analyzer操作分析
3.1開啟Actix_ Analyzer軟體

(1) 雙按桌面Actix_Analyzer執行程式捷徑，開啟後畫面如下：[image: image10.wmf] 
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(2) 使用”Help”
從主選單選擇”Help”，裡面分別有二種方式提供協助：

-Help → Contents

-Help → Attribute Help
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個人可依據需求或使用習慣，操作本項線上求助功能。

3.2 設定Actix_ Analyzer軟體
(1) 設定組態

在main menu中選擇“Tools → Preference”
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註：不同的Binning Mode，不會影響在Table(或Workbook)中Statistic及Histogram
Binning:
–係一種將訊息及統計資料結合以及平均處理的方法。
–使用於maps, charts, reports/workbooks。

–當”Analysis Manager”啟動後，設定時可能會變動。

–4種模式：Time、Distance、Message及Location。
(2) 查詢Cell Site Database

(3) 選擇”Tools”→”Network Explorer”。
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(4) 鍵入欲查詢之site ID(勿輸入”G”或”D”)並按下 “Find Next”。
(5) 基地台資料出現後，雙擊 “GSM_Cell Elements”目錄以檢視細胞組態資料。
(6) 該基地台所有細胞均顯示出。
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(7) 亦可開啟”All GSM_Cell Element”以顯示所有細胞，惟需花上一段時間等候，於此期間勿點擊”Detailed View”項下的任何選項。可按”Stop”停止資料之建立。
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3.3 開啟路測檔
方法有二：

(1) 從檔案總管中點選路測檔案(*.sd5)並按住滑鼠左鍵(or右鍵)， 直接將檔案拖曳至Analyzer’s Workspace Explorer。
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(2) 在Button Bar中點選 “Open Logfile”(或由主選單File→選擇Open Logfile)並選擇欲分析之路測檔案(*.sd5)。
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3.4 Workspace Explorer資料結構
Explorer資料結構如下：
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(1)：查測檔一般訊息。
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(2)：GPRS data testing log。
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(3)：GPRS handset log。
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(4)：GSM handset log - GSM手機所蒐集資料記錄於此。
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(5)：RF Scanner log – RF Scanner掃瞄訊息記錄於此。
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3.5 Maps方式顯示

(1) Analyzer主要地圖顯示功能如下：
(可將手機或掃描器量測的資料，單筆或多筆同時以GIS方式呈現。
(地圖控制功能與MapInfo相似。
(接受tab格式的街道地圖圖檔。
(2) RxLev/RxQual格式

(RxLev：
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–<-90 dBm：         (紅)

–-90<= X < -80 dBm： (黃)

–-80<= X < -70 dBm： (藍)

–>= -70 dBm：       (綠)

(RxQual：
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–0 ~ 2：             (綠)

–3 ~ 5：             (黃)

–6 ~ 7：             (紅)
(3) Event格式：

( Dropped Call event: D
( Dropped Call custom attribute labeled with CI: D
( Handover OK event: H
( Handover OK custom attribute labeled with CI: H
( Handover Fail event: H
( Handover Fail custom attribute labeled with CI: H
( Cell Update OK custom attribute labeled with CI: U
( DL TBF Abnormal Release custom attribute labeled with CI: B
( UL TBF Abnormal Release custom attribute labeled with CI: b
3.6 顯示資料於地圖上

欲顯示資料於地圖上，僅需於該屬性(Attribute)上按右鍵並選擇”Display on Map”即可。
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3.7 基地台呈現方式設定

預設細胞樣式設定係以BCCH做顏色區分，若欲更改可按下”Cell Sites”按鈕開啟” Map Options”對話框更改設定。
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(1) 步驟1：於”Map Options”對話框中展開BCCH設定項，將” Field Style”設為”None”。

(2) 步驟2：展開EIRP設定項，選取”Field Style”之”Size”，再按下“確定”鍵關閉對話框。爾後若無變動，細胞樣式設定將依據EIRP size。然而，以EIRP size做為細胞樣式，預設顏色係為黑色，故每次開啟新圖時都必須重新做一次設定。
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3.8 更改基地台顯示顏色

(1) Step1：Right-click on “GSM_Cell-EIRP – Beamwidth –”                 and select “Multi-d dataset Style”.

(2) Select a preferred color and hit “確定”.
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3.9 顯示/設定距離及經緯度
(1) 在地圖上按下滑鼠右鍵，點選“Show Scal”或 “Show Lat/Lon”。
(2) 在地圖上按下滑鼠右鍵，點選“Map Units”→“Distance”, 選擇適用的距離單位。
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3.10 單一地圖顯示多筆路測資料
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點選 attribute中將預顯示之資料，直接按下滑鼠左鍵拖曳至 map window

3.11調整Map Layers
調整Map Layer：可點選快速鍵或在地圖上按下滑鼠右鍵，點選 “Map Layers”。

[image: image3]
3.12 在 Map 中加入街道圖層
(1) 開啟「Layer Control」對話框
方法一：點選「Layer Control」快速鍵

[image: image4]
方法二：於Map中，按下滑鼠左鍵，選擇Map Layers
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(2) 於「Layer Control」對話框中點選「Add」按鈕， 然後開啟街道圖層(如TPEC25_R.TAB) TAB 檔案即可。
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3.13 在 Map 中加入HO with CI
(1) 步驟一：將ServRxLevSub/ServRxQualSub資料放入Map

(2) 步驟二：開啟“Tools”→“Custom Attribute Manger”功能選項，並選擇“HO_OK_CI，再按下執行鍵(Run)。

(3) 步驟三：至Attribute中點選該手機之“Common”→ “Time Series”→“HO_Ok_CI”，直接拖曳至Map。
(4) 步驟四：開啟「Layer Control」對話框，將“HO_Ok_CI”圖層中”Lables”→“Visibility” 點選  “Show”
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3.14 調整 Legend範圍
在地圖左側點選“data series name”按下滑鼠左鍵並選擇 “Modify Ranges”
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3.15 調整 Legend形狀/大小/顏色
(1) 將Legend的內容以形狀/大小/顏色等方式表示，設定方式在地圖左側點選“data series name”按下滑鼠左鍵並選擇 “Style Setting”

(2) 進一步設定Legend個別形狀/大小/顏色：點選Legend區間並按下滑鼠左鍵選擇“Selected range’s style”

(3) 目前有關RxLev / RxQual Legend範圍/顏色統一由網維處三科制定。
(4) 其餘項目如ServC1 and ServC2可依上述方式進行修改。

(5) Legend修改內容存放在：

 C:\Program Files\Actix\Analyzer\Bin\FormatGroups\UserSettings
3.16 拉線至相關細胞
(1) 設定方式：

進入Layer Control：可點選快速鍵或在地圖上按下滑鼠右鍵，點選 “Map Layers”。

點選 “Lines to serving cells”或“Lines to Neighbor Cells” layer，再點選“Lines”進一步設定Line Layer Properties。
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(2) 效果：查測點自動拉線至服務細胞(實線)及相關鄰細胞(虛線)。
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3.17 啟動SiteData Viewer
(1) 在程式上方主功能鑑中點選 “View→SiteData Viewer”

(2) 在地圖上點選預查詢的基地台圖示。
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3.18 設定SiteData Viewer內容
游標移至 SiteData Viewer中按下滑鼠右鍵並點選“Information Filter”，及可依個人喜好設定SiteData Viewer顯示內容。
[image: image66.png]=M
B

Statistis Data. | Display Protacol Stack Browser

i Dedioaed Rodi  Display Replay

§ Devicelnfo | Display StateFomms

g Serving CellPe gy





3.19 複製/匯出 Map圖像
(1) 複製：將Map直接複製到Office的文件中( Word or Power Point file )。游標移至Map任一處，按下滑鼠右鍵並選擇 “Copy to Clipboard”，至Office的文件中選取“貼上”。

(2) 匯出：將Map 直接匯出另存成圖片檔(BMP、JPG等格式)。游標移至Map任一處，按下滑鼠右鍵並點選 “Export Map”並選擇預匯出之圖檔格式。

[image: image67.png]Disgl
Display new Map,
Display on Map
Display on Chart
Display on Teble
Display on Workbook.
SiData Viewer

Sttistcs Explorer

18-

RN




3.20 Charts方式顯示
(1) 資料顯示於圖表(Charts)

選擇一屬性(Attribute)按下右鍵以開啟彈出式選單，並點選“Display on Chart”使資料顯示於圖表上。
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預設以點陣序列圖(dot series chart)方式呈現
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放大：在圖示上點選放大矩形的左上角，向右下方向拖拽滑鼠成一個矩形。

縮小：在圖示上點選縮小矩形的右下角，向左上方向拖拽滑鼠成一個矩形。

游標移至在Chart圖示中，可利用壓住滑鼠右鍵，上、下、左、右移動圖示。
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亦可自Workspace Explorer拖放(Drag&Drop)其他屬性(Attribute)至圖表中。
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3.21 於圖表(Charts)中加入Event Data

直接拖放(Drag&Drop)Event Data至圖表中即可。
[image: image73.png]% ot G Hy

Togele Next Previous Clear | Copy




3.22 匯出/複製圖表(Exporting/copy Charts)

在Chart任一處按下滑鼠右鍵選擇“Image Export”或“Copy”，可將Chart繪出所選擇的圖形格式或直接Copy至Office相關檔案。
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3.23 Tables方式顯示
(1) 資料顯示於表格(Tables)：選擇一屬性(Attribute)按下右鍵以開啟彈出式選單，並點選“Display on Table”使資料顯示於圖表上。
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(2) 在屬性(attribute)上點選欲觀察資料直接拖曳至已開啟(相同的) table上。
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3.24 訊息瀏覽視窗(Message Browser)
開啟 Message Browser：在attribute上點選“手機或掃描器”並按下滑鼠右鍵，選擇“Message Browser”，或點選主要功能選項中“View ( Display Message Browser”。
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3.25 Message Browser 格式
如下圖。

3.26 Message Panel
上鏈(UL)訊息對齊右側，下鏈(DL)訊息對齊左側。
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3.27 Message 格式設定
可按”Properties”鍵開啟”Properties”對話框，或於訊息視窗中按右鍵並選擇”Properties”。

3.28 在訊息中尋找相關文字訊息
點選Message Browser上方快速鍵中空白下拉式視窗，輸入欲尋找之文字訊息然後按下「Find Next」或「Find Prev」，便可快速尋找出所輸入之訊息文字。


3.29 複製 Messages
欲拷貝所選取訊息至剪貼簿，可於選取範圍按右鍵選擇”Copy”或直接點擊”Copy”鍵。


3.30 加入我的最愛/儲存工作區 
(1) 加入我的最愛
a.經常使用的 Attributes 可放在「我的最愛」中以方便檢視(如：SerRxLevSub, SerRxQualSub等)。

b.在 Attribute 上按下滑鼠右鍵並選擇「Add To Favorites」即可將Attribute加入「我的最愛」。
c.於「我的最愛」中，在 Attribute 上按下滑鼠右鍵並選擇「Remove Favorite」，即可將Attribute由「我的最愛」中移除。

加入我的最愛


移除我的最愛
(2) 儲存工作區 (Workspace)
a.至主選單選擇「File→Save Workspace As」 即可將目前所分析之場測檔案之工作區儲存起來，以利多次分析。
b.可將習慣的操作介面儲存如：Map、Replay等(不包含查測檔)。

c.可直接開啟Workspace檔(*.aws)。
3.31 Workbooks/Reports使用方法
(1) 開啟Report：至主選單選擇「Workbook ( Open Workbook/Report」開啟預先完成之Report。

(2) 選擇Report種類與Device：選擇欲開啟 Report後，出現選擇 device之對話方塊，俟按下OK鍵後，則完成Report 開啟。 Report 開啟後必須立即以「另存新檔」儲存該檔案，以防止預設Report被更改(切勿修改預設之 Report 範本)。

(3) 本分公司現用Reports說明：
a.Template_Summary_GSM.xls：GSM報表。
b.UDP_V1_0714.xls：GPRS報表。

c.FTP_V1_0714.xls：GPRS報表。

d.行政區場測專用WOKBOOK(ACTIX) .xls：執行定期行政區場測報表。

肆、建議

有機會奉派出國赴承商原廠受訓，除了能夠於專業知識上有所成長，亦可從訓練過程中，體會到國外技術人員敬業的工作態度。

本次受訓以GSM及GPRS領域之軟體操作應用為重心，而於3G部分之分析介紹並無著墨。本分公司3G Phase I工程建設已自去(92)年底前開始推動，同時於工程案中購進6套(Phase I)RSV，其中後級亦使用Actix Analyzer為處理工具。鑒於3G第一階段工程即將完成建設，後續品改優化作業勢必將如火如荼展開，建議針對各中心PIP品改人員積極進行3G專業技術的培訓作業，以利未來新系統之順利上線服務。
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Step 1.


輸入欲查詢之文字訊息
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按下Find Next或Find Prev





Step 3.
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N.B. Gc & Gs interfaces are optional
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